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Copyrights

Copyrights

© Cypress Semiconductor Corporation, 2009-2011. The information contained herein is subject to change without notice.

Cypress Semiconductor Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in a

Cypress product. Nor does it convey or imply any license under patent or other rights. Cypress products are not warranted

nor intended to be used for medical, life support, life saving, critical control or safety applications, unless pursuant to an

express written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as critical components

in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user.

The inclusion of Cypress products in life-support systems application implies that the manufacturer assumes all risk of such

use and in doing so indemnifies Cypress against all charges. 

Any Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by

and subject to worldwide patent protection (United States and foreign), United States copyright laws and international treaty

provisions. Cypress hereby grants to licensee a personal, non-exclusive, non-transferable license to copy, use, modify, create

derivative works of, and compile the Cypress Source Code and derivative works for the sole purpose of creating custom soft-

ware and or firmware in support of licensee product to be used only in conjunction with a Cypress integrated circuit as speci-

fied in the applicable agreement. Any reproduction, modification, translation, compilation, or representation of this Source

Code except as specified above is prohibited without the express written permission of Cypress. 

Disclaimer: CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS MATE-

RIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A

PARTICULAR PURPOSE. Cypress reserves the right to make changes without further notice to the materials described

herein. Cypress does not assume any liability arising out of the application or use of any product or circuit described herein.

Cypress does not authorize its products for use as critical components in life-support systems where a malfunction or failure

may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product in a life-support sys-

tems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all

charges. 

Use may be limited by and subject to the applicable Cypress software license agreement. 

PSoC® is a registered trademark of Cypress Semiconductor Corporation. All products and company names mentioned in this

document may be the trademarks of their respective holders.

Purchase of I2C components from Cypress or one of its sublicensed Associated Companies conveys a license under the

Philips I2C Patent Rights to use these components in an I2C system, provided that the system conforms to the I2C Standard

Specification as defined by Philips. As from October 1st, 2006 Philips Semiconductors has a new trade name - NXP Semicon-

ductors.

Flash Code Protection

Cypress products meet the specifications contained in their particular Cypress PSoC Data Sheets. Cypress believes that its

family of PSoC products is one of the most secure families of its kind on the market today, regardless of how they are used.

There may be methods, unknown to Cypress, that can breach the code protection features. Any of these methods, to our

knowledge, would be dishonest and possibly illegal. Neither Cypress nor any other semiconductor manufacturer can guaran-

tee the security of their code. Code protection does not mean that we are guaranteeing the product as "unbreakable."

Cypress is willing to work with the customer who is concerned about the integrity of their code. Code protection is constantly

evolving. We at Cypress are committed to continuously improving the code protection features of our products.
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1. Introduction

1.1 Safety Precautions

■ Use the board with expert technical supervision. There is high voltage (110-V, 240-V AC) power 

on the board.

■ Accidental human contact with high voltage is dangerous.

■ The capacitors on the board can be energized even after disconnecting the board from the main 

power supply. Be careful not to touch any parts on the board immediately after you disconnect the 

main power supply.

■ Safety plastic casing is provided on the top of the high voltage section. Do not touch the 

protected area during live operation for debugging, probing, or for any other purpose. 

Cypress bears no responsibility for any consequences that may result from the improper or

hazardous use of this board. 

1.2 Using the PLC Kit

Cypress’s Powerline Communication Solution (PLC) makes it possible to transmit command and

control data over high voltage and low voltage powerlines. This solution is developed for low

bandwidth powerline communication. 

The CY3274 PLC high voltage (HV) PLC development kit provides the capability to develop an appli-

cation on the Cypress CY8CPLC20 device that can transmit and receive data over high voltage

(110 V to 240 V AC) powerlines. 

■ Chapter 1 provides a brief overview of the Cypress PLC solution. It describes the contents of the 

CY3274 development kits and lists special features of the kit. 

■ Chapter 2 gives the functional overview of the PLC board and describes the operating procedure 

of PLC HV board. It provides a high level hardware description of the board. 

■ The Appendix contains the schematics, layout, and bill of materials.

1.3 The Cypress PLC Solution 

Powerlines are available everywhere in the world. This makes them one of the most widely available

communication media. The pervasiveness of powerlines also makes it difficult to predict their

characteristics and noise. Because of the variability of powerline quality, implementing robust

communication over powerline has been an engineering challenge for years. With this in mind, the

Cypress PLC solution is designed to enable secure, reliable, and robust communication over

powerlines. 

CAUTION: High Voltage (Risk of Electric Shock)

Extreme care is necessary when you work with powerline communication 

equipment. 

Use caution when using power supplies or power related equipment.

[+] Feedback 
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The key features of the Cypress PLC solution are:

■ An integrated powerline PHY modem with optimized filters and amplifiers that work with rugged 

high and low voltage powerlines

■ Powerline optimized network protocol that supports bidirectional communication with 

acknowledgement based signaling and multiple retries

■ Support for 8-bit packet CRC and 4-bit header CRC for error detection and data packet 

retransmission 

■ Carrier Sense Multiple Access (CSMA) scheme that minimizes collisions between packet 

transmissions on the powerline

The Cypress PLC solution consists of three key elements as shown in Figure 1-1.

■ Powerline network protocol layer

■ Physical layer FSK modem

■ Power amplification and coupling circuits

Figure 1-1.  Cypress PLC Solution Block Diagram

The powerline network protocol layer and the physical layer FSK modem are implemented on the

CY8CPLC20 chip. The chip also contains a PSoC core in addition to the PLC core. The CY3274

board contains the CY8CPLC20 device along with the power amplification and coupling circuit for

communicating on high voltage (110-240 V AC) powerlines. For a detailed description of the design

parameters for the circuit, refer to the application note Cypress Powerline Communication Board

Design Analysis - AN55427. 

[+] Feedback 
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The network protocol layer allows for the addressing of multiple nodes on the network. This enables

point-to-multipoint communication. The protocol layer also provides a defined packet structure for

transmitting data packets from one node to the other as well as error detection and packet retransmit

functionalities. The chip contains a PSoC core in addition to the PLC core. The PSoC core includes

configurable blocks of analog and digital logic, and programmable interconnects. This architecture

enables you to create customized peripheral configurations that match the requirements of each

individual application. A fast CPU, flash program memory, SRAM data memory, and configurable 

I/Os are also included.

A two-node system level diagram is shown in Figure 1-2. To evaluate this kit, follow the steps in the

quick start guide, which is provided in the kit.

Note To evaluate this kit, a second high voltage PLC kit is required. The compatible kits are CY3274

(this kit) and CY3272 High Voltage PLC Evaluation Kit, with EZ-Color. For information on these kits,

visit http://www.cypress.com/go/CY3274 and http://www.cypress.com/go/CY3272.

Figure 1-2.  PLC System Level Block Diagram – Two Nodes

1.4 Kit Contents

The CY3274 PLC HV development kit contains:

■ CY3274 quick start guide

■ CY3274 PLC HV development board

■ CDs containing:

❐ Packet test software – PLC Control Panel application 

❐ PLC Control Panel release notes

❐ CY3274 release notes

❐ CY8CPLC20 datasheet 

❐ Development board user guide

❐ CY3274 board Altium design project

❐ CY3274 board schematics, layout, and BOM

❐ Application note – Using CY8CPLC20 in Powerline Communication (PLC) Applications

❐ PSoC Designer™

❐ PSoC Programmer

■ AC power cable

■ MiniProg1 to program CY8CPLC20

■ 25 jumper wires 
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■ LCD module

■ USB-I2C bridge

■ Retractable USB cable

■ Five CY8CPLC20-28PVXI SSOP device samples

1.5 Additional Learning Resources

Visit  http://www.cypress.com/go/plc for additional learning resources in the form of datasheets, tech-

nical reference manuals, and application notes. 

■ CY3274 Schematic.pdf

http://www.cypress.com/?rID=38026

■ CY3274 Board Layout.zip

http://www.cypress.com/?rID=38026

■ CY3274 Kit documentation

http://www.cypress.com/go/CY3274

■ For a list of PSoC Designer-related trainings, see

http://www.cypress.com/?rID=40543

■ CY8CPLC20 data sheet

http://www.cypress.com/?rID=38201

■ For more information regarding PSoC Designer functionality and releases, refer to the user guide 

and release notes on the PSoC Designer web page:

www.cypress.com/go/psocdesigner

■ For more information regarding PSoC Programmer, supported hardware, and COM layer, go to 

the PSoC Programmer web page:

www.cypress.com/go/psocprogrammer

■ AN54416, Using CY8CPLC20 in Powerline Communication (PLC) Applications

http://www.cypress.com/?rID=37951
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1.6 Document Revision History 

1.7 Documentation Conventions 

Table 1-1.  Revision History

Revision

PDF 

Creation 

Date

Origin 

of 

Change

Description of Change

** 8/14/09 IUS New kit guide.

*A 9/3/09 IUS Rework for external release.

*B 12/10/09 RARP Content updates

*C 09/28/10 RKPM
Added Software Installation, Example Projects, and Technical Refer-

ence sections. Added schematic in section 2.3. 

*D 03/08/2011 FRE

Added references to the compatible high voltage PLC kits. Added a ref-

erence to the quick start guide for evaluation. Added clarifications to the 

text throughout.

*E 10/12/2011 ADIY

Removed reference to CY3276 and CY8CLED16P01. Updated Figure 

1-2. Updated hyperlinks. Updated section 1.5. Added Getting Started 

section.

Table 1-2.  Document Conventions for Guides

Convention Usage

Courier New
Displays file locations, user entered text, and source code:

C:\ ...cd\icc\

Italics
Displays file names and reference documentation:

Read about the sourcefile.hex file in the PSoC Designer User Guide.

[Bracketed, Bold]
Displays keyboard commands in procedures:

[Enter] or [Ctrl] [C]

File > Open
Represents menu paths:

File > Open > New Project

Bold
Displays commands, menu paths, and icon names in procedures:

Click the File icon and then click Open.

Times New Roman
Displays an equation:

2 + 2 = 4

Text in gray boxes Describes cautions or unique functionality of the product.
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2. Getting Started

This chapter describes how to install and configure the CY3274-HV PLV Development Kit.

2.1 Kit Installation

To install the kit software, follow these steps:

1. Insert the kit CD into the CD drive of your PC. The CD is designed to auto-run and the Kit 

Installer Startup Screen appears.

2. Click Install CY3274 High Voltage PLC Kit to start the installation.

Figure 2-1.  Kit Installer Startup Screen

[+] Feedback 
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Note If auto-run does not execute, double-click the cyautorun.exe file on the root directory of the CD.

Figure 2-2.  Root Directory of CD

3. The CY3274-HV PLV Development Kit - InstallShield Wizard screen appears. Choose the 

folder location to install the setup files. You can change the location of the folder using Change.

4.  Click Next to launch the kit installer.

Figure 2-3.  CY3274-HV PLV Development Kit - InstallShield Wizard

[+] Feedback 



CY3274 Cypress High Voltage Programmable PLC Development Kit Guide, Doc. # 001-53598 Rev. *E 13

Getting Started

5. On the Product Installation Overview screen, select the installation type that best suits your 

requirement. The drop-down menu has the options Typical, Complete, and Custom, as shown 

in Figure 2-4. 

6. Click Next to start the installation.

Figure 2-4.  Installation Type Options

[+] Feedback 
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7. When the installation begins, a list of all packages appears on the Installation Page.

8. A green check mark appears next to every package that is downloaded and installed.

9. Wait until all the packages are downloaded and installed successfully.

Figure 2-5.  Installation Page

[+] Feedback 
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10.Click Finish to complete the installation.

Figure 2-6.  Installation Completion Page
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2.2 PSoC Designer

1. Click Start > All Programs > Cypress > PSoC Designer <version> > PSoC Designer <ver-

sion>.

2. Click File > New Project to create a new project on the PSoC Designer menu or go to File > 

Open Project/Workspace to work with the existing project on the PSoC Designer menu

Figure 2-7.  PSoC Designer Interconnect View

3. For more details on PSoC Designer, go to Help Topics from the following directory:

<Install_Dir>\Cypress\PSoC Designer\<version>\PSoC Designer 5\Help\PSoCDesigner

(Compiled HTML Help file)

[+] Feedback 
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2.3 PSoC Programmer

1. Click Start > All Programs > Cypress > PSoC Programmer <version> > PSoC Programmer 

<version>.

2. Connect the MiniProg from Port Selection.

Figure 2-8.  PSoC Programmer Window

3. Click the File Load button to load the hex file.

4. Use the Program button to program the hex file on to the chip.

5. When the file is successfully programmed, Programming Succeeded appears on the Action 

pane.

6. Close PSoC Programmer.

Note For more details on PSoC Programmer, go to Help Topics from the following path:
<Install_Dir>\Cypress\Programmer\<version>\PSoC_Programmer(Compiled HTML Help file)

[+] Feedback 
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2.4 Software Installation

2.4.1 Before You Begin

All Cypress software installations require administrator privileges; however, this is not required to run

the installed software.

■ Shutdown any Cypress software that is currently running.

■ Disconnect any Cypress devices (USB-I2C bridge, ICE Cube, or MiniProg) from your computer.

2.4.2 Prerequisites

The PLC Control Panel GUI requires the latest versions of Microsoft .NET Framework, Adobe Acro-

bat Reader, and a Windows Installer. If your computer does not have .NET Framework and Windows

Installer, the installation automatically installs it. However, if your computer does not have Adobe

Acrobat Reader, download and install it from the Adobe website.

2.4.3 Installing PLC Control Panel Software

The PLC Control Panel GUI is installed as a prerequisite when you install the CY3274 PLC HV

Development kit. Follow the steps shown on the screen to complete the installation. If you need to

reinstall this application, select Install PLC Control Panel GUI from the installation screen, as shown

in Figure 2-1 on page 11.

Click Start > All Programs > Cypress > PLC Control Panel > PLC Control Panel.

The PLC Control Panel application controls the CY3274 PLC HV Development Kit over USB inter-

face from a PC. The application's startup display, when a board is attached and operating, is shown

in the following figure.

[+] Feedback 
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Figure 2-9.  PLC Control Panel

After installing PLC Control Panel, refer to the documentation as needed: 

<CD Drive>\Software\PLC Control Panel\PLC Control Panel Release Notes.pdf

<CD Drive>\Software\PLC Control Panel\User Guide for Cypress PLC Control Panel

GUI.pdf

The PLC Control Panel user guide is also available in the installation directory. It contains extra infor-

mation about installation and how to set up the kit to work with the GUI. It can also be accessed from

the Help menu in the PLC Control Panel GUI.

[+] Feedback 
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3. PLC Development Board

This chapter explains the key features of the CY3274 development board. 

3.1 Features

The key features of the CY3274 development board are: 

■ User friendly PLC Control Panel application available on kit CD

■ CY8CPLC20-OCD – 100-pin TQFP on-chip debug (OCD) device that allows quick design and 

debug of a PLC application. 

The CY8CPLC20 100-pin TQFP is available for debug purpose only. For production quantities, 

CY8CPLC20 is available in 28-pin SSOP and 48-pin QFN packages.

■ Chip power supply derived from 110 V to 240 V AC

■ User configurable general purpose LEDs

■ General purpose 8-position DIP switch

■ On board surge protection and isolation circuit

■ RJ45 connector to use ICE debugger 

■ RS232 COM port for communication

■ Header to attach the LCD card

■ I2C header for communicating to external device

■ ISSP header for programming the CY8CPLC20

3.2 CY3274 PLC Development Board Functional Overview

The CY3274 PLC development board is designed as a product development platform for low

bandwidth (up to 2400 bps) powerline communication.

The user-written application running on the CY8CPLC20 generates the data. The PLC core

encapsulates this data into a PLC network packet. The FSK modem then modulates this packet and

the coupling circuitry incorporates the resulting sinusoidal waveform on to the existing waveform on

the high voltage bus.

3.2.1 Operating Conditions

■ Input voltage: 110 V AC/240 V AC

■ Input current: 100 mA/50 mA

■ Operating temperature: 0 °C to 40 °C

■ Operating humidity condition: 5% to 95% relative humidity (RH), non-condensing

[+] Feedback 
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3.3 Hardware Description

The programmable high voltage PLC development board is shown in Figure 3-1. Key sections on the

board are highlighted.

Figure 3-1.  Front View of Cypress Programmable PLC HV Development Board

The core of the PLC HV board is the CY8CPLC20 chip. The communication signal flows on this HV

board as follows: 

Transmit: CY8CPLC20 TX pin (FSK_OUT) → Transmitter Filter Circuitry  → Power Amplifier Cir-

cuitry  → High Voltage Powerline Coupling Circuitry  → High Voltage Powerline (110 V to 240 V AC)

Receive: High Voltage Powerline (110 V to 240 V AC) → High Voltage Powerline Coupling Circuitry

→ Passive Low Pass Filtering → Vdd/2 Biasing → CY8CPLC20 RX pin (FSK_IN)

The CY3274 board can be divided into seven main sections:

■ Development

■ LCD daughter card

■ RJ45 connector for debugging

■ RS232 COM port

■ High voltage with SMPS

■ Transmit amplifier and filtering

■ High voltage coupling circuit

Potentiometer (R47)

-> Connected to VR

High Voltage AC-DC

Power Supply

High Voltage PLC

Coupling Circuit

RS232 Interface

I2C Connector (J15) 

and Jumpers 

(JP1, JP3, JP4, JP5)

LCD Connector

-> Connected to Port4

Push-button (S4)

-> Connected to SW

Potentiometer (R46)

-> For LCD Contrast

Transmit Filter, Transmit

Amplif ier, and Receive Filter

Reset Push-button (S2)

CY8CPLC20 PLC Device 

with On-Chip Debugger (U1)

General LEDs

-> Connected to LED1-4

ISSP Programming

Connector (J21)

RJ45 Debugger 

Connector (J14)

PLC RX, TX, BIU Indicator

LEDs (DS2, DS3, DS4)

AC Power

Connector (J7)

Breadboard with 

surrounding GPIO headers

DIP Switch (S3)

-> Connected to J12
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3.3.1 Development 

3.3.1.1 User I/Os, Bread Board and GPIO Headers

This is the area where you make custom designs. All GPIO pins excluding those required for PLC

communication are routed to this area for ease of access. Some of the pins are shared for other pur-

poses (for example, the port 4 pins P4[6:0] are also connected to the LCD connector).

Header J18 has pins that are connected to user I/Os (potentiometer, push-button, and LEDs). In

Figure 3-2, these connections are represented by the green arrows. To connect one of these user 

I/Os to a CY8CPLC20 pin, connect a jumper wire between the respective header pins. For example,

to connect the push-button S4 to pin P1[6], place a jumper wire in SW on header J18 and the other

end in P16 on header J9. 

The DIP switch bank S3 is not connected directly to any of the CY8CPLC20 pins. The DIP switch is

connected to header J12, so that a jumper wire can be connected to any of the pins. The DIP switch

is active LOW (connected to GND when in the ON position).

Figure 3-2.  Bread Board

Potentiometer (R47)

Push- button (S4)

General LEDs

DIP Switch (S3) with

Header (J12)

Port0 Analog/Digital Port (J13)

Free: P01, P02, P04, P07

Port2 Digital Port (J16)

BIU LED: P21

RX LED: P23

TX LED: P25

Free: P26

Port4 Digital Port (J1)

LCD: P40– P46

Free: P47

Port1 Digital Port (J9)

I2C: P15, P17

Free: P12, P16

Port3 Digital Port (J10)

Free: P30– P37

Port5 Digital Port

Free: P50– P53
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3.3.1.2 CY8CPLC20 PLC Device

This section has the CY8CPLC20-OCD device, which has the integrated transmit and receive

modem and network protocol. It also has the I2C header for optional communication with an external

host processor. The ISSP header is provided to program the device. The device also has built-in

debug support using the RJ45 connector for use with the ICE debugger. There are also three

dedicated LEDs, which can be used to indicate communication on the powerline: green LED for TX,

red LED for RX, and yellow LED for BIU.

Figure 3-3.  The Development Section

Table 3-1.  Headers and Jumpers

Headers and Jumpers Description

BIU LED[DS4]
Yellow LED that can be used to indicate when the transmit frequency band 

is in use.

CY8CPLC20-OCD
Cypress Powerline transceiver chip. It is a 100-pin on-chip debugger (OCD) 

device.

J8
Two-pin header for connecting to Vcc and Gnd for debug. Do not use these 

pins to power an external board.

JP1 (PWR)

This jumper should be connected to power an external board. After this 

jumper is connected, power for the external board can be derived from the V 

(VDD) and G (Gnd) connectors on the I2C header (J15). The CY3274 board 

can provide a maximum of 50 mA at 5 V to an external board through the V 

and G pins on the I2C header (J15). 

JP5 (Reset)

The jumper enables the reset of the PLC device through an external board. 

After this jumper is connected, the external board reset can be connected to 

the R (Reset) pin on the I2C header (J15).

5V PWR Jumper (J1)

Connects 5V to I2C Connector

Reset Jumper (J1)

Connects XRES to I2C Connector

I2C-SDA Pull-up (JP4)

Connects I2C SDA line to a pull-up resistor 

I2C-SCL Pull-up (JP3)

Connects I2C SCL line to a pull-up resistor 

PLC RX, TX, BIU Indicator

LEDs (DS2, DS3, DS4)

CY8CPLC20 PLC Device with On-

Chip Debugger (U1)

I2C Connector (J15) 

5V Power Indicator LED (DS1)

ISSP Programming

Connector (J21)

Reset Push-button (S2)
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JP4 (I2C-SDA)

This is a pull-up jumper. While communicating through I2C (J15), one side 

has to pull up the line. When the jumper is connected, the SDA line is pulled 

high. This needs to be done when the user wants the I2C link to be pulled up 

by the CY3274 board.

This jumper does not need to be placed if the USB-I2C bridge is used for 

communication to the host.

JP3 (I2C-SCL)

This is a pull-up jumper. While communicating through I2C (J15), one side 

has to pull up the line. When the jumper is connected, the SCL line is pulled 

high. This needs to be done when the user wants the I2C link to be pulled up 

by the CY3274 board.

This jumper does not need to be placed if the USB-I2C bridge is used for 

communication to the host.

J15

V  –  VDD. This pin can provide a maximum of 50 mA at 5 V to an external 

board. This pin is only to source the current. DO NOT SUPPLY POWER TO 

THIS PIN FOR POWERING CY8CPLC20 DEVICE. Note that the PWR 

jumper (JP1) needs to be connected to enable this functionality.

G  –  Gnd. The Gnd pin can provide the ground reference to an external 

board. This pin connects to the ground plane of the CY3274 board.

D  –  I2C data (SDA). The I2C data pin is the data line for the I2C communi-

cation. This pin is directly connected to the CY8CPLC20 device. See appro-

priate I2C-SDA jumper (JP4) settings before connecting I2C bus to this pin. 

C  –  I2C clock (SCL). The I2C clock pin is the clock line for the I2C commu-

nication. This pin is directly connected to the CY8CPLC20 device. See 

appropriate I2C-SCL jumper (JP3) settings before connecting I2C bus to 

this pin. 

R  –  Reset. Connecting this pin to an external board enables the 

CY8CPLC20 chip to be reset by an external board. Note that the RES 

jumper (JP5) needs to be connected to enable this functionality.

LCD Contrast[R46] Adjusting this potentiometer adjusts the contrast on the LCD Daughter Card.

LED1-LED4 Headers connected to general purpose configurable LEDs.

PWR LED[DS1] Blue LED that glows when the board is powered on.

P01, P02, P04, P07 Free analog/digital port pins

P15 Port pin connected to SDA for I2C

P16, P12 Free port pins

P17 Port pin connected to SCL for I2C

P21 Port pin connected to yellow LED for BIU

P23 Port pin connected to red LED for RX

P25 Port pin connected to green LED for TX

P26 Free port pin

P30, P31, P32, P33, P34, 

P35, P36, P37
Free port pins

P40-P46 Port pins connected to LCD card

P47 Free port pin

P50, P51, P52, P53 Free port pins

Headers and Jumpers Description
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3.3.2 LCD Daughter Card

The LCD module is connected to header LCD1 and controlled with the CY8CPLC20 port 4 pins

P4[6:0].

Figure 3-4.  LCD Daughter Card

Connect the LCD daughter card to the main board as shown in Figure 3-5. The contrast of the LCD

is controlled by the potentiometer R46.

Figure 3-5.  LCD Daughter Card Board Connection

R47
This is a variable resistor (potentiometer) that connects to the VR header. It 

can be used to generate a voltage between +5 V and GND.

RX LED[DS2] Red LED that can be used to indicate when the board is receiving data

S2 Reset switch for resetting the CY8CPLC20-OCD chip

S3[7-0]
These dip switches are general purpose and can be routed to any port of the 

CY8CPLC20 chip.

SW
Header connected to the switch S4. S4 is a general purpose switch. Active 

HIGH (connected to VDD when pressed).

TP1, TP2, TP3, TP4
Grounded test points to facilitate probing/debugging. These test points 

connect to the board ground plane.

TX LED[DS3]
Green LED that can be used to indicate when the board is transmitting data 

on to the powerline

VR Header connected to the potentiometer R47

Headers and Jumpers Description

Potentiometer R46

-> For LCD Contrast
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3.3.3 RJ45 Connector for Debugging

The RJ45 ICE Cube Emulation Connector (J14) provides a debug interface between the

CY8CPLC20 device and the ICE Cube emulation tool using the PSoC Designer software

application. A CY3215-DK In-Circuit Emulation Development kit is required to interface the PC to

this board. It can be purchased at http://www.cypress.com/go/CY3215-DK.

Figure 3-6.  RJ45 Connector

3.3.4 RS232 COM Port

The RS232 COM Port can be used with a standard RS232 cable to connect two RS232 capable

devices together. The RS232 (J20) header is a four pin header that has connections for the RX, TX,

RTS, and CTS lines. These need to be wired to port pins to connect the device to the respective pins

on the RS232 DB9 port. 

Figure 3-7.  RS232-COM

Table 3-2.  Controls Associated with Port

Control Description

RX The board receives the RS232 information through this pin.

TX The board transmits RS232 information through this pin.

RTS The host asks the chip if it can send information through this pin.

CTS The chip signals that it is ready to accept information through RX.
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3.3.5 High Voltage with Switched Mode Power Supply (SMPS)

This section takes the power from the powerline and generates necessary low DC voltage for the

operation of the PLC transceiver and other components on the chip. 

Table 3-3.  Key High Voltage with SMPS Components

The key components are circled in the following schematic

Figure 3-8.  Power Supply Schematic

3.3.6 Transmit Filter, Transmit Amplifier, and Receive Filter

The transmit signal from the FSK_OUT pin of the CY8CPLC20 device is filtered (for FCC and

CENELEC compliance) and amplified (for driving the signal on the powerline). The passive receive

filter prepares the signal for the FSK_IN pin of the CY8CPLC20 device.  

Table 3-4.  Key Transmit Amplifier and Filtering Components

Component Description

J7 This is the two pin connector where the AC cable hooks up to the powerline. 

F1 Protection fuse for the circuit.

D7 Full wave bridge rectifier diode IC.

T3 Common mode choke.

U6 iW1690-07 – iWatt high performance AC/DC power supply controller.

T2 Flyback transformer.

U5 5-V regulator.

Component Description

U2, U3 

These opamps filter the signal from the CY8CPLC20 removing the harmonics. The filter 

stages are only required to meet FCC Part 15 and/or European CENELEC EN50065-1:2001 

signaling specifications. They are not required to achieve robust PLC communication.

U4, Q1, Q2 These opamp and high gain transistors are used for the power amplification stage.
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The key components are circled in the following schematic.

Figure 3-9.  Transmit Filter, Transmit Amplifier, and Receive Filter

3.3.7 High Voltage Coupling Circuit

This circuit couples the signal from the board on to the powerline. On the receive side, the same

circuit couples the carrier on the powerline into the board, while rejecting the actual 50-Hz and 60-Hz

power. The isolation transformer in the circuit is required for safety. 

Table 3-5.  Key Transmit and Receive Components

Component Description

T1 
This is the isolation transformer that isolates the HV and LV sections of the board. It has a 1:1 

turns ratio. 

C9 

This is the coupling capacitor that couples the communication signal to the powerline and 

rejects low frequency noise. The voltage rating and X1/X2 safety ratings of this component 

are important parameters.
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The key components are circled in the following figure. 

Figure 3-10.  Coupling Circuit

3.4 Code Example

The CY3274 kit is designed for systems that require a communication interface over commercial

high-voltage Powerlines. The CY8CPLC20 device combines the robustness and ease-of-use of the

PLC solution with the configurability and flexibility of the PSoC core. The CY8CPLC20 device

provides the ability to run your own application. The PLT User Module manages the network protocol

and the physical layer FSK modem, which transmits and receives messages over the powerline. For

more information on this user module, see AN54416, Using CY8CPLC20 in Powerline

Communication (PLC) Applications.

3.5 Technical Reference

For a real-time list of knowledge base articles for the CY3274 Kit, refer to our Online Knowledge

Base.

For any help with the installation of the control panel, refer to the Control Panel User Guide provided

in the kit CD. You can also download the latest revision of the GUI setup and user guide from

www.cypress.com/go/plc. 
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A. Appendix

A.1 Schematics

A.1.1 Board Overview
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A.1.2 User Interface
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A.1.3 Transmit and Receive Filters and Coupling
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A.1.4 Power Supply
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A.2 Layout

A.2.1 Top Layer
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A.2.2 Ground Layer
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A.2.3 Power Layer
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A.2.4 Bottom Layer
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A.2.5 Top Silkscreen
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A.2.6 Bottom Silkscreen
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A.3 Bill of Materials

Description Designator Quantity Value Manufacturer
Manufacturer 

Part#
Digi-Key#

Capacitor 0.1 µF C1 1 0.1 µF PCC1864TR-ND

Capacitor Ceramic 

1.0 nF X7R 10% 25V 

C0603

C2 1 1.0nF Murata
GRM033R71E1

02KA01D
490-3184-1-ND

Capacitor Ceramic 

0.01 µF 25V X7R 0603

C3, C4, 

C10, C36
4 0.01 µF AVX

06033C103JAT

2A

06033C103JAT2A

-ND

Capacitor Ceramic 

0.1 µF 25V X7R 0603
C5 1 0.1 µF AVX

06033C104JAT

2A
478-3713-1-ND

Capacitor Ceramic 

1.0 µF 16V X7R 0603

C6, C12, 

C13, C14, 

C15

5
1.0 µF, 

1 µF
Taiyo Yuden

EMK107B7105

KA-T
587-1241-1-ND

Capacitor Ceramic 

22 pF 100V C0G 0603
C7, C8 2 22pF Murata

GRM1885C2A2

20JA01D
490-1335-1-ND

CAP .15UF 300VAC 

INTER SUPP X1
C9 1 0.15 µF Murata

ECQ-

U3A154MG
P11117-ND

Capacitor 1.0 µF, 16V C11 1
1.0 

µF,16V
PCC1849TR-ND

CAP CERM 0.10 UF 

10% 16V X7R 0603

C16, C17, 

C18, C24, 

C27, C34

6 0.1 µF Panasonic
ECJ-

1VB1C104K
PCC1762CT-ND

CAP CERM 10.0 UF 

10% 25V X5R 1206

C19, C26, 

C33
3 10.0 µF Taiyo Yuden

TMK316BJ106

KL-T
587-1337-1-ND

Capacitor Ceramic 

1000 PF 1% 5V NP0 

0603

C20, C21, 

C22, C23
4 1.0nF AVX

06033A102FAT

2A

06033A102FAT2A

-ND

Capacitor 0.47 µF, 16V
C25, C38, 

C42
3

0.47 

µF,16V
PCC1847TR-ND

Capacitor Ceramic 

470 PF 250VAC X1Y1 

RAD

C28 1 470pF TDK
CD95-

B2GA471KYNS
445-2407-ND

CAP .022UF 300VAC 

INTER SUPP X1
C29 1

0.022 

µF
Panasonic

ECQ-

U3A223MG
P11112-ND

Capacitor Electrolytic 

4.7 µF, 400V
C30, C31 2

4.7 µF, 

400V
Nichicon

UVR2G4R7MP

D
493-1229-ND

C30, C31 

(2nd 

Source, 

105C rated)

4.7 µF, 

400V

United Chemi-

Con

EKMG401ELL4

R7MJ16S
565-1411-ND

Capacitor Electrolytic 

330 µF 16V 20%
C32 1

330 µF, 

16V
Nichicon

UPW1C331MP

D
493-1784-ND

[+] Feedback 



42 CY3274 Cypress High Voltage Programmable PLC Development Kit Guide, Doc. # 001-53598 Rev. *E

Capacitor Electrolytic 

10 µF 50V 20%
C35 1

10 µF, 

50V
Nichicon

UPW1H100MD

D
493-1890-ND

Capacitor 0.1 µF, 16V C37 1
0.1 

µF,16V
PCC1864TR-ND

Capacitor 100 pF C40 1 100pF 399-1121-2-ND

Capacitor Ceramic 

1500 pF 10% 50V X7R 

0603

C41 1 1500pF Yageo
CC0603KRX7R

9BB152
311-1184-2-ND

Transorb Voltage Sup-

pressor 430 V 1250A 

ZNR

D1 1 430V Panasonic ERZ-V07D431 P7251-ND

Dual Schottky Diode D6 1 ST Micro BAT54SFILM 497-2522-1-ND

Full Wave Diode Bridge D7 1 Fairchild DF10S DF10SCT-ND

Schottky Diode 100 V 

1A SMA
D8, D9 2 Diodes Inc B1100-13-F B1100-FDICT-ND

Transient Voltage Sup-

pressor 400 W 12 V 

BIDIRECT SMA

D10 1
Micro Com-

mercial Co
SMAJ12CA-TP

SMAJ12CA-TPM-

SCT-ND

LED Blue Clear 0603 DS1 1 Rohm
SML-

E12BC7TT86
511-1589-1-ND

LED Red Clear 0805 DS2 1 Lite-On
LTST-

C170KRKT
160-1415-1-ND

LED Green Clear 0805 DS3 1 Lite-On
LTST-

C170KGKT
160-1414-1-ND

LED Yellow Clear 0805 DS4 1 Lite-On
LTST-

C170KSKT
160-1416-1-ND

Fuse 2A Slow Blow 

250 V AC
F1 1 2.0A Bel Fuse RST 2 507-1179-ND

3M solderless bread-

board super strip
H1 1 Parallax 700-00012 923273-ND

Header, 10-Pin
J1, J10, 

J12, J18
4 10

929850E-01-36-

ND

AC Power Connector J7 1 Schurter 4300.0097

Header, 2-Pin, Female J8 1 2
Generic Com-

ponents

929850E-01-36-

ND

Header, 4-Pin
J9, J13, 

J17, J20
4 4

929850E-01-36-

ND

ICE Connection J14 1 Tyco 5557785-1 A31457-ND

5-pin ISSP Header J15, J21 2 Molex 22-23-2051 WM4203-ND

Description Designator Quantity Value Manufacturer
Manufacturer 

Part#
Digi-Key#
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Header, 4-Pin J16 1 4
929850E-01-36-

ND

Female DB-9 J19 1 DB9-F A23301-ND

(DO NOT POPU-

LATE)   Power Connec-

tor Jack 2.1mm PCB

J22

(DO NOT POPU-

LATE)   Right Angle 

2X13 header 0.1" 

Spacing

J23

Header, 2-Pin, Male
JP1, JP3, 

JP4, JP5
4 2

Generic Com-

ponents
S1011E-36-ND 

Inductor 1500 µH 0.2A 

5% Radial
L3 1 1.5mH Taiyo Yuden LHL08TB152J LHL08TB152J-ND

Inductor 22 µH 20% 

1210
L4 1 22 µH Taiyo Yuden

CBC3225T220

MR
587-1626-1-ND

Inductor 1 mH 10% 

1007
L5 1 1mH Taiyo Yuden CB2518T102K 587-2195-1-ND

14-Pin header, Female LCD1 1 14 3M/ESD
929850-01-36-

RA

929850E-01-36-

ND

Red LED

LED1, 

LED2, 

LED3, 

LED4

4 Red Lumex Opto
SML-

LXT0805IW-TR
67-1552-2-ND

Mounting Holes

MTG1, 

MTG2, 

MTG3, 

MTG4

4

Transistor NPN HV 

40 V 1A SOT-89
Q1 1 Zetex FCX491ATA FCX491ACT-ND

Transistor PNP HV 40 V 

1A SOT-89
Q2 1 Zetex FCX591A FCX591ACT-ND

Transistor NPN SOT-23 Q3 1 Fairchild MMBT3904LT1
MMBT3904LT1IN

CT-ND

NPN Silicon Planar 

Medium Power High-

Gain Transistor

Q4 1 TSC TS13003HVCT

Q4 (2nd 

source)
ST Micro STX616-AP 497-7625-1-ND

Resistor 1.00k 1% 1/

10 W 0603

R1, R3, R4, 

R25
4 1.00k Yageo

RC0603FR-

071KL

311-1.00KHRTR-

ND

Description Designator Quantity Value Manufacturer
Manufacturer 

Part#
Digi-Key#
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Resistor 2.1k 1% 1/

10 W 0603
R2 1 2.10k Rohm

MCR03EZPFX2

101

RHM2.10KHCT-

ND

Resistor 402 1% 1/

10 W 0603
R5 1 402 Yageo

RC0603FR-

07402RL
311-402HRTR-ND

Resistor 7.50k 1% 1/

10 W 0603

R6, R7, 

R22
3 7.50k Yageo

RC0603FR-

077K5L

311-7.50KHRTR-

ND

Resistor 330 Ohm 1% 

1/10 W 0603
R8 1 330 Rohm

MCR03EZPFX3

300
RHM330HCT-ND

Resistor 20.0 k 1% 1/

10 W 0603
R9, R11 2 20.0k Yageo

RC0603FR-

0720KL

311-20.0KHRCT-

ND

Resistor 2.0k 1% 1/

10 W 0603
R10 1 2.0k Yageo

RC0603FR-

072KL

311-2.00KHRCT-

ND

Resistor 22.1 1% 1/

10 W 0603
R14 1 22.1 Yageo

RC0603FR-

0722R1L

311-22.1HRCT-

ND

Resistor 10.0k 1% 1/

10 W 0603

R15, R17, 

R18, R28, 

R29, R30, 

R31, R33

8 10.0k Yageo
RC0603FR-

0710KL

311-10.0KHRTR-

ND

Resistor 4.02k 1% 1/

10W 0603
R16 1 4.02k Yageo

RC0603FR-

072K02L

311-4.02KHRTR-

ND

Resistor 37.4k 1% 1/

10 W 0603
R19, R20 2 37.4k Yageo

RC0603FR-

0737K4L

311-37.4KHRCT-

ND

Resistor 3.83k 1% 1/

10 W 0603
R21 1 3.83k Yageo

RC0603FR-

073K83L

311-3.83KHRCT-

ND

Resistor 4.99 1% 1/

10 W 0603
R23 1 4.99 Yageo

RC0603FR-

074R99L

311-4.99HRCT-

ND

Resistor 36.5 1% 1/

10 W 0603
R26 1 36.5 Yageo

RC0603FR-

0736R5L

311-36.5HRCT-

ND

Resistor 41.2 1% 1/

10 W 0603
R27 1 41.2 Yageo

RC0603FR-

0741R2L

311-41.2HRCT-

ND

750 k 1% Resistor 1206 R32 1
750k, 

1%
Yageo

RC1206FR-

07750KL

311-750KFRCT-

ND

820 k 1% Resistor 1206 R34 1
820k, 

1%
Yageo

RC1206FR-

07820KL

311-820KFRCT-

ND

3.9 Ohm 1% Resistor 

0805
R35 1 3.9 Yageo

RC0805FR-

073R9L

311-3.90CRCT-

ND

RES 68.0 K OHM 1/8W 

1% 0805 SMD
R36 1

68k, 

1%
Yageo

RC0805FR-

0768KL

311-68.0KCRTR-

ND

RES 1.00 OHM 1/10W 

1% 0603 SMD
R37 1 1.0 Yageo

RC0603FR-

071RL

311-1.00HRCT-

ND

Description Designator Quantity Value Manufacturer
Manufacturer 

Part#
Digi-Key#
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RES 100 k OHM 1/10W 

1% 0603 SMD
R38 1 100k Yageo

RC0603FR-

07100KL

311-100KHRTR-

ND

RES 12.0 K OHM 1/

10W 1% 0603 SMD
R39 1

12k, 

1%
Yageo

RC0603FR-

0712KL

311-12.0KHRCT-

ND

6.8k, 1% Resistor 0603 R40 1
6.8k, 

1%
Yageo

RC0603FR-

076K8L

311-6.80KHRTR-

ND

RESISTOR 10.0 OHM 

5W 5% WIREWND
R41 1 10, 5W Vishay

AC0500000100

9JAC00

PPC5W10.0CT-

ND

Potentiometer R46, R47 2 Bourns Inc 3352T-1-103LF 3352T-103LF-ND

Resistor 1.0 K, SMT

R48, R49, 

R50, R51, 

R61, R62, 

R63, R64, 

R65

9 1K Panasonic
ERJ-

6GEYJ102V
P1.0KACT-ND

Resistor 56 Ohm, SMT
R57, R58, 

R59, R60
4 56 P56ACT-ND

Swtich, SPST S2, S4 2 Omron B3F-1022 SW403-ND

4009 Series DIP 

Switch, Raised actuator
S3 1 ESwitch KAJ08LAGT EG4441-ND

Isolation Transformer T1 1
Precision 

Components
0505-0821G

Power Trasnsformer 

EE-16
T2 1 3.2mH

Shenzen 

Goldenway

EE-16 (5+5) 

(rev-A)

T2 (2nd 

Source)
1

Renco Elec-

tronics
RLCY-1014

24 mH Common Mode 

Choke
T3 1 24mH

Shenzen 

Goldenway

EE8.3(2+2)-

hori, (rev-A)

T3 (2nd 

Source)
1

Renco Elec-

tronics
RLCY-1013

Simple Test point
TP1, TP2, 

TP3, TP4
4 5006K-ND

CY8CPLC20 OCD Part U1 1 Cypress
CY8CPLC20-

OCD

Op-Amp 190 MHz U2, U3, U4 3

National 

Semiconduc-

tor

LMH6639MF/

NOPB

LMH6639MFCT-

ND

Voltage Regulator 5 V U5 1 ST Micro
LD1117DT50CT

R
497-1237-1-ND

Off-Line Switcher U6 1 iWatt iW1690-07

Description Designator Quantity Value Manufacturer
Manufacturer 

Part#
Digi-Key#
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RS-232 tranceiver 

(1.0 µF Caps)
U8 1 MAX3232ECDR 296-19851-2-ND

Oscillator Y1 1
24.00 

MHz
Crystek C3290-24.000 C3290-24.000-ND

Y1 (2nd 

Source)
Citizen

CSX750FCC24.

000M-UT
300-7214-2-ND

Crystal 32.768 kHz 

12.5 pF
Y2 1

32.768

kHz
ECS Inc. ECS-3X8X X1123-ND

LCD Module LCD1 1

Cypress 

Semiconduc-

tor

1187-00003

Description Designator Quantity Value Manufacturer
Manufacturer 

Part#
Digi-Key#
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